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1. INTRODUCTION

Documentation of the IT landscape is created for various reasons - e.g. due to audits, certifications or
emergency planning. One of the requirements of IT documentation is that it must be consistent, dynamic,
up-to-date and reusable.

The classic documentation, without an available database, as provided by Docusnap, does not meet these
requirements at all or only to a limited extent.

Classical documentation stirs up resistance to the creation of documentation. These resistances can result
from IT staff not having time, being overloaded or having other priorities. In most cases, it is the time it takes
to create documentation.

This is exactly where Docusnap and the IT concepts come into play. Docusnap provides information about
systems, services and applications via automatic inventories. Within the IT concepts, you can now make this
information usable so that it can be brought into context and understood.

In addition, the great advantage of the IT concepts is that the data there is dynamic and therefore up-to-
date, based on the inventories.

This HowTo describes the steps and functions necessary to successfully create an IT concept. These includes:
o the basics and understanding of IT concepts - Chapter 2

o the basic text editor functionalities - Chapter 3

. inserting content - Chapter 4

o the output of the finished IT concepts - e.g. in a PDF - Chaper 5

. managing concepts - e.g. versioning and automatic exports - Chapter 6

o the creation of concept templates that can be reused across customers - Chapter 7
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1.1. UPLOAD HOWTO AND SAMPLE CONCEPTS IN DOCUSNAP

The IT concept HowTo is available either by integrating the demo database (Docusnap program
directory\Templates\Docusnap.bak) or by downloading it from our website
(www.docusnap.com/en/support/knowledge-base/).

The download from our website took place as a ZIP file. Within this ZIP file you have received the PDF
version as well as the exported concepts, IT concept HowTo.dcc.

Chapter 6.6 describes how to load concepts into Docusnap.
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2. IT CONCEPTS

Within the IT department, documentation on various areas must be prepared on a regular basis. Docusnap
collects information about systems, applications, services and permissions through the integrated inventory
wizards. In addition to this automated collection, information can also be added manually - e.g. assets,
additional information or diagrams.

This information can be viewed individually within the data areas, plans and reports.

The concepts in Docusnap offer you the possibility to create a structured complete documentation. Content
of this complete documentation can be all information sources from Docusnap itself (reports, plans, data
areas etc.), external documents and static content (prose texts, tables, images etc.).

The IT concepts in Docusnap can be found in the Documentation - Concepts module.

The selection of the tree object Concepts shows the tab Concepts with specific controls.

You can generate the first concept by right-clicking on Concepts and then selecting Create concept.

4] L Conepts
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-----------
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The dialog for creating a concept will open. Here you can select a concept name and an existing template
or empty document.

After the selection and naming has been completed, the concept editor is opened.
Ribbon bar

o Settings for formatting, content, view etc.

Objects

. Within the objects, all explorers from the different modules are displayed.

. Reports, data elements, etc. can be dragged and dropped into the concept using these.
Document layout

. The structure of the document is displayed here.

Document

. In this area, the document is created and the added content is displayed.
Variables

. Variables for date, page number, title, creation date, etc.

Tasks

. Placeholders stored in the concept are described here one after the other and can be edited by
selecting the button.

Error list
o Inside the Ribbon - Document - you will find the Validate button.

. The concept is then checked and the error list (e.g. deleted diagrams) is displayed.
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3. STRUCTURE

The concept editor in Docusnap provides you with the most common structural elements that you can use
to create a structured document.

Within the Ribbon - Page Layout, you can set page size, orientation, margins, wraps, etc.

The Insert tab lists controls that you can use to insert the various contents, static and dynamic, into the
concept. With regard to the construction of a structure, the table of contents and the header and footer
should be mentioned in particular. The other contents are described separately in Chapter 4.

On the General tab, you can save and export the concept, perform formatting, apply style sheets, and set
up paragraphs.

Please note that the concept editor is not a full Word replacement. The concept editor is a separate text
editor that does not have the functionality of Microsoft Word.
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3.1. STRUCTURING THE CONCEPT

We start by building the structure:
. cover page

. table of contents

. header and footer

For the cover page, you need the Style Title and the Variables Title, Date Created and Date Modified.
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The variable Title was selected for the title. Drag and drop the variable into the concept. Afterwards, you can
adjust the formatting using format templates - place the cursor in front of or behind the inserted variable. If
you select the inserted variable, you cannot apply style sheets.

The variables Date Created and Date Modified were also used.

Note: Formatting of a variable can only be performed using format templates!
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@ Docusnap

In the next step, the table of contents is inserted on a new page (Ctrl + Enter). The table of contents can be
found in the tab Insert - Table of Contents:
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For example, if you click on the heading of the table of contents, or later on on the structure, you can edit
the title of the table of contents and make further adjustments:

& |9 < | Close
GEMERAL  INSERT PAGELAYOUT | TABLE OF COMTENTS

O —Seperator - [EJEdit Title

Refresh Delete  +=Line Spacing ~

=+ Indent

Edit Settings
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Now we add a header and a footer to the concept. You will also find the selection for this in the Insert tab
and the Header and Footer group.

After selecting one of the two buttons, you can start the editing.

A new tab - Design (Header and Footer) - is available for selection. Here you can set the position and
options. Here you will also find the option that the header and/or footer on the first page should be
displayed differently or should not be present at all.
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You can add variables for the headers and footers using Insert-Area - Variable.
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3.2. CUSTOMIZE STYLE SHEETS

You can adjust the existing style sheets within the concept editor.

IMPORTANT to know that an adjustment of the style sheets only affects the style sheets within the selected
concept.

This means that you should adapt the style sheets accordingly before creating a concept and save this
change in the form of a new template (see chapter 7)!

You can adjust the style templates with a right click - Change.
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4. CONTENT

The concepts distinguish between static and dynamic content.

By static content we mean the content that you manually store in the concept - e.g. prose texts, tables,
images, etc.

The dynamic contents are based on the information stored in Docusnap from the inventory or manual
input and are added and created via a selection from the Insert area or via drag & drop from the object
tree.

A link to this information is stored. If any of this information changes during inventory or manual input, these
changes are also adjusted in concept - see chapter 5 for more information on automatic updating.
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Red marked are static contents and orange marked are dynamic contents.

Below File you will find dynamic and static files.
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4.1. STATIC CONTENTS

You can store the following static content in a concept using the Insert tab:

Spreadsheets

Pictures

Hyperlinks

o Also hyperlinks within the concept / document

Text Boxes

Quick Parts

Static Files

o File contents of external documents can be integrated and then edited within the concept editor
o The following file formats are supported:

. * doox;*. doc* xtx.rth* xml *.pdf * . htm;* html *.csv;* xIs;* xIsx; *.png;* jpg;* jpeg; *.bomp; * tif;* .t
iff,*.emf;*.gif, *. vsd;*. vdx;*. vsdx

o For the static import of Visio files, Visio must be installed.
Placeholders

. Placeholders are suitable for creating templates - see chapter 7 for application examples

IT Concept HowTo | (c) 2021 - All rights reserved Page 15 of 54



IT Concept HowTo | Docusnap GmbH @ Docu S na pc

4.2. DYNAMIC CONTENTS

Dynamic contents are the following and are based on the data stock from the Docusnap database. This
database is maintained through inventories and manual entries.

Reports
Maps
Diagrams
Data

Data Sheets
Fields
Dynamic Files

Variables
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4.2.1. REPORTS

@ Docusnap

Select a report from the object tree - for example, IT Structure Key Figures (Company - Infrastructure -
Domain - Management) and add it to the concept using Drag & Drop.

The Report tab is now available. Here you have the option Remove page breaks. Activate this option to
remove the page breaks defined in the report - this way the report adapts better to the concept and its

page size.
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4.2.2. MAPS

When integrating the available plans
o network map

o topology map

o location-based network map
. rack map

. VMware

° etc.

you must note that there are two types of maps. The standard maps (ad hoc plans) from the data tree and

the maps from the documentation area.

Standard Maps / Ad Hoc maps

The standard maps (ad hoc plans) are generated when the corresponding map is selected and are therefore

always up-to-date.
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Maps from the documentation

The maps from the documentation area are created once, stored on the file system (documentation path)
and then included in the concept. Therefore, when using these maps, it must be taken into account that they
are regularly recreated and thus updated!

Furthermore, it should be noted that these can also be VMware, HyperV, SQL, ADS plans, etc., which are
only available in this area.

Why do you want to use plans from the documentation area within a concept even though they are not
automatically up-to-date?

On the one hand, you want to use these plans because you can make further settings for the standard maps
here. You can use the wizard to select how the map is to be created. For example, you can apply filters to
system types or select only certain systems to be displayed in the map.

On the other hand, this is the only way you can create plans for Active Directory, DHCP, VMware, HyperV,
and so on.
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@ Docusnap

If you have now integrated a map into the concept, you can then edit the labeling and scaling:

Igl

Close

GEMERAL MSERT  PAGELAYOUT | MAP

Fiy

O N [=]Edit Caption

Refresh Delete | Draft (100 %
View
Edit
Below you will find the integrated network map.

If you now do a right-click on the map and select Update, the network map of your environment will be
placed.
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Illustration: Network Map
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4.2.3. DATA

Data stands for the data areas in Docusnap - e.g. the tabular view of all inventoried servers. You can include
these in the concept using Drag & Drop. The Docusnap Connect packages available in the data tree can also
be stored in the concept.

The following is a list of all inventoried Windows servers:

Name Type Virtualization Host Virtualized
DOSPBKO1 Server sesx14.intern.local Yes
DOSPDBO1 Server sesx15.intern.local Yes
DOSPDCO1 DC sesx14.intern.local Yes
DOSPDCO02 DC sesx15.intern.local Yes
DOSPEXO1 Server sesx15.intern.local Yes
DOSPFSO1 Server sesx15.intern.local Yes
DOSPFS02 Server sesx14.intern.local Yes
DOSPFS03 Server DOSPHYO01/ DOSPHYO1-  Yes

N7
DOSPHY01-NT1 Server sesx14.intern.local No
DOSPHYO1-N2 Server sesx14.intern.local No
DOSPSPO1 Server sesx15.intern.local Yes
DOSPSQO1 Server sesx14.intern.local Yes
DOSPWUO02 Server sesx14.intern.local Yes
DOSPWUO3 Server sesx15.intern.local Yes
DOSPWUO05 Server sesx14.intern.local Yes
DOSPWUO06 Server sesx15.intern.local Yes

Below are the members of the Domain Administrators group:

Name ADS Container
adm_docusnap OU=ADMINISTRATION,DC=DSRA,DC=LOCAL
adm_ham OU=ADMINISTRATION,DC=DSRA,DC=LOCAL
adm_ima OU=ADMINISTRATION,DC=DSRA,DC=LOCAL
Administrator CN=Users,DC=DSRA,DC=LOCAL
dsraBCK CN=Users,DC=DSRA,DC=LOCAL

If you include such a list, you can double-click to select the columns to be displayed and set filters.

An asterisk "*" stands for filtering as a placeholder. You can separate more than one filter criterion with a
comma "," - e.q. Filter]-* Filter2-*
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4.24. FIELDS

@ Docusnap

(Variable) fields are individual values for available objects - for example, the host name of a system, the
name of an ADS user, and much more.

For example, if you drag and drop the object of a server into the concept, the Data Selection window
appears. Here you have the following options

o Add Data Element (this content type was described in the previous chapter) and

. Add Variable Field

Select Variable field and then the desired column - e.g. Name
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An application example refers to the cover pages of the concepts. For example, you could store your
company information such as name, address, telephone, etc. here. If anything changes in this data, the new
data is automatically updated for all concepts.

Furthermore, this example can also be applied to our system house customers who create cross-customer
templates. By using fields the company information is loaded automatically.

For more information on the templates, see chapter 7.

Company Name Docusnap Sports

Address Franz-Larcher-Str. 4, 83088 Kiefersfelden, Germany
Phone +49 8033 6978 - 4000

E-Mail info@docusnap.com

4.2.5. DATA SHEETS

Within the data sheets you will find all the information that has been inventoried for a system. Within the
data tree you will find the data sheets as reports - e.g. System Summary - below a Windows Server.

4.2.6. DYNAMIC FILES

In chapter 4.1 the integration of static files was discussed - in short, this is the copying and pasting of content
from external documents. The further processing of the files takes place within the concept in Docusnap.

This is different for dynamic files - here you load the content from external documents into the concept. If
the external document is now changed, this change is also adopted in the concept.

If the external document is deleted or renamed, it can no longer be included:

File Element
Erro while loading of the elements. (C:\Users\KRE\Desktop\Dynamic File.png)

Selected file does not exist!
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The following file formats are supported for dynamic import:
* docx;*. doc* axt . rtf* xml *.pdf . htm;* html *.csv;* xIs;* xIsx; *.png;* jpg; * jpeg; *.omp;* tif, * tiff,*.emf;*.gif

PDF files are not 100% supported. It may happen that parts of the document cannot be imported or
formatted correctly.

For Excel files, the appropriate ACE drivers must be installed (64 bit or 32 bit - depending on OS and
Docusnap version).

Importing Excel files will fail if the 32-bit version of Office is installed, but the system itself is 64-bit.
The following error message occurs during import:
ACE drivers are not installed. Please visit......

You must also note that Visio files can only be integrated statically. An alternative to this is to convert the
Visio file into an image file and integrate it into the concept as a dynamic file.
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4.2.7. THE DYNAMICS IN DETAIL

All dynamic content is reloaded on the current basis when the concept is updated.

@ Docusnap

If the concept is updated after 6 weeks (manually or automatically), you have automatically

within the concept on the current state.

The prerequisite for this is that the inventories are carried out in a planned manner.

the current server inventory and other system overviews

software installations

releases and their authorizations

group memberships

etc.
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4.3. DRAFT VIEW

Your concept can grow rapidly over time as you add more dynamic content. To keep the concept clear for
you, you can move the dynamic content to a draft view that requires only a fraction of the space.

In the tab General you will find the button Draft View - this will move all contents into the design view:

You can also move only individual content to the draft view by right-clicking on the content and then
selecting Draft View.
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5. OUTPUT

You can export finished IT concepts manually or automatically according to a schedule and thus make them
available outside Docusnap.

5.1. MANUAL EXPORT

The manual export is carried out in the course of the currently logged in user and can be carried out via the
Export button in the General tab
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After selecting the button the Export Concept dialog appears. Here you have the possibility to adapt the
concept name and to specify the export path.

ExportConcept

Concept Name:
Export Path:
[ ]1Refresh Concept before Export

[

[]Create Directory Structure

Select Format

Microsoft Word 2007 and above (*.docx)
[ Microsoft Word 97 - 2003 (*.doc)

[~] Adobe PDF-Document (*.pdf)

[ PDF/A-Document (*.pdf)
HTML-Document (*.html)

[ ]Rich Text Format (*.rtf)

Cancel

Refresh Concept before Export

The dynamic contents are inserted on the basis of the current inventories. Reports, plans etc. are brought up
to date.

Save Version of Old Concept

If an older version of the concept is to be recorded before export and saved below the concept, this can be
done with the help of this function. However, this is only possible if the option Refresh Concept before Export
was selected beforehand. Otherwise, the function is grayed out for you (see previous figure).

Create Directory Structure

Using this function, the directory structure created in Docusnap is also set up on the file system and the
concepts are stored in the corresponding folders.
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5.2. AUTOMATED EXPORT

@ Docusnap

The Docusnap server service can be used as an automated export. The time-controlled order is realised via
the button Schedule as Job. It is important to note here that the user or the stored service account of the
server service has sufficient authorizations (Change) for the specified documentation path.
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In the first step of the wizard, you select whether the IT concepts are to be stored on an alternative
documentation path.

In step 2 you select the concepts and the file format which are to be exported via this job.

Documentation a x

Concepts

#| Refresh Concept before Export 7| Save Version of Oid Concept [ Create Dirgctory Struciure

PDF EDOC 1 DOCK [~]RTE =] HTML

Avaiable Concepts

Mame Crested
O B Benutzer Ubersicht 19.06.2019
= B Data Quality in Docusnap 2B06.2019
O Bl Datengualitst in Doousnap 19.06.2019
El Bl Docusnap Concepts 06.02.2018
0 Bl Docusnap Konzepte D6.02.2018
|| E IT Concept HowTo 01,07.2019
O Bl IT Konzept HowTe 05.06.2019
[0 Bl Rack Docurnentation 19.06.2019
[0 El Rack Dokumentation 19.06.2019
O B System Overviews 28062019
O B1 System Obersichten 19.06.2019
[0 Bl The first concept 24.04.2020
O B User Overview 28062019

Back Mot Cancel

Here you have the same options that were already introduced during the manual export:
. Refresh Concept before Export

o Save Version of Old Concept

o Create Directory Structure

Be aware of the importance of the option Refresh Concept before Export and activate it! This option
ensures that your documentation remains up-to-date and that reports, plans, etc. are reloaded.
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@ Docusnap

5.2.1. E-MAIL DISTRIBUTION

Step 3 gives you the opportunity to send the previously selected concepts directly by e-mail. For this,
however, you must have configured the e-mail settings of the Docusnap server service.

Documentation

Distribution
[] E=Mail Distribution
Recipient: | redpient@doousnapuoom
Subject: Doousnaps Automatic export and e-mail sending of concepts

Message: |The automatically exported and mail-sent concepts are avallable in the attachment,

Back Mot Cancel
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5.3. FILE FORMATS FOR EXPORT

Both the manual and automatic export of the concepts provides you with the following file formats:
. Microsoft Word from 2007 (*. docx)

. Microsoft Word 97 - 2003 (*. doc)

. Adobe PDF document (*. pdf)

. PDF/A document (*. pdf)

. HTML document (*. html)

. Rich Text Format (*.rtf)
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6. MANAGE CONCEPTS

6.1. BACKUPS

As soon as you save a concept, a backup version is created. This offers you the possibility to fall back on
older versions and also to recognize changes better. The backups can be found in the tree structure, below
the concept, in the subfolder Backups.

W Docusnap Sports
> E—? IT Documentation
» Documents
b Concepts
> 5DE
~ [ EN
~ [ 01 - Docusnap Recommendatior
~ Docusnap Concepts
> [ Versions
~ [ Backups
EZ 01/04/2020 12:5340
EZ 01/04/2020 12:53:08
E& 01/04/2020 12:49:25
E& 01/04/2020 12:4350
EZ 19/06/2018 15:2807
EZ 19/06/2018 15:2703
E& 19/06/2018 15:2628
E& 19/06/2018 15:2537
EZ 19/06/2018 13:32:57
E% 19/06/2018 13:31:58
> [ 02 - Sample Concepts
» IT Concept HowTo
> The first concept
> o< Diagrams
H EI Physical Infrastructure
> &o Standard Maps
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Up to 10 backups per concept are stored by default. The number of versions can be adjusted in the Options
- Documents dialog in the main Docusnap interface. If the stored number is reached, older backups are
overwritten.

@® Options

@ General Maps Datashests IT Concept

Versions & Backup
lnvegnitory Number of Backups: 10
a Nurnber of Versions: 105
Documentation

s
IT Security

&)

Licerie
Management

QK Cancel

Two buttons are available on the Versions/Backup tab:
. Restore

. Keep

] ) Dustiets B = o Begertion % Hemter FLieep

You can use the Restore function to restore a created backup. The current state of the concept is replaced
by the selected backup version.

The Keep button can be used to specify that the selected backup will not be deleted. The Delete function is
then grayed out.
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6.2. VERSIONS

In addition to the backups, you can also create different versions of an IT concept. The extension or change
of a version status is thus better comprehensible.

If the concept is open, such a version can be created via the button Save and then As New Version.

& Close
GEMERAL MSERT PAGE LAYOUT

O |— |gj @ ﬁl:'aste [3!:

%
Save Refresh Export Print Draft L
View
Save Edit
@ As New Version n Docusnap Cot
B As Template n

This version can be found below the concept in the subfolder Versions.

w Docusnap Sports
» E—? IT Documentation
? Documents
¥ Concepis
> = DE
> [ EN
~ [ 01 - Docusnap Recommendations
hd Docusnap Concepts
~ [ Versions
3 24/04/2020 14:25:50 - 10
» [ Backups
> 202 - Sample Concepts
» IT Concept HowTo
b The first concept
> o< Diagrams
» a Physical Infrastructure
» 34: Standard Maps

As already described in chapter 6.1 the number of versions, as well as the recovery and fixation can be
performed identically to the backups.
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6.3. COMPOSITION

In many cases, it makes sense to divide up larger concepts so that it is easier to edit it by several colleagues.
This makes it possible to combine several concepts into a complete document using the Composition
function. If the individual concepts are changed, this also has an effect on the compiled document.

If the Concepts node is selected in the inventory tree, the Add button is available for selection in the
Composition tab. Thus a new combination of individual concepts can be realized.

Dacowery
" Templatm B Som Concrpt B Loss Conopo P Migrate oot ion & scradue s lot
5 _ (3 A C
=
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Opening the dialog for the composition requires fields, which must be filled in. You can enter the name for
the document in the top left-hand corner. To the right the author is deposited. In the standard system, the
logged-in user name is entered, which can be adjusted manually. The Created and Modified fields are
dynamically affected when the document is saved.

Manage IT Concept Composition g x
Compaosition
Marme: IT concept - How To - Complete Authon Admin
Createdt 24042020 14:48 Medified: | 24,04.2020 14:48
IT Concepts in Composition
T [Section Break: |(On Mew Page = Header & Footer: Mo Heades/Footer .
- Bh Docusnap Sports e Mpmg Aigthor Descripicn
v N —T
- B EN El IT Concept HowTo Dwoousnap Consulting
B2 01 - Docusnap Recommendations
* [El Docusnap Concepts
» B3 02 - Sample Concepts
> 11T Concept HowTo
> ] The first concept
Save Close

In the left field all concepts of the current company are listed. Using the arrow buttons >> and <<, the
concepts can be added or removed.

The Section break drop-down box determines whether the selected concept should start on a new page or
be added to the next line after the end of the previous concept.

For the header and footer, you can define whether no header/footer, the header/footer of the previous
concept, or the header/footer of the selected concept is to be used.
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@ Docusnap

If the dialog is closed with the Save button, the merged document is saved in the inventory tree. The
contents are loaded after you have chosen the tab Update Concept have chosen.
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6.4. DIRECTORY

Within the tree structure, you can create concept directories and store the concepts in them. A new directory
can be created by right-clicking Create Concept Directory or by clicking on the New - Concept Directory
button. Existing concepts can be moved between the directories by drag & drop.

The created directory structure can be created on the file system for both manual and automated exports.

b Docusnap Sports L
> E—? IT Documentation

» Documents 4
W Concepts = r

> 3 DE Actions

~ B3 EN =] Create Concept
= 01 = Create Concept Directory

AT

» B0z - Customize Company Settings ...
> 1T cd Filter
> BT C
> E] The Apply Filter
3 D“‘;Diagrams Remowe Filter
» EI Physical li Remove all Filters

» 3.4: Standard Maps
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6.5. STORE CONCEPTS

The dialog for saving existing concepts and concept templates is opened in the Other tab via the Store
Concepts button. You can use the checkboxes to select the objects you want to save. Saving also serves as
an export option so that the concepts can be used in other Docusnap environments using the import
function (next chapter - Loading Concepts).

Store IT Concepts/Templates

W 'gd' Documentation
£ Templates
e Docusnap Sports
v s Concepis
? = DE
v [ EN
b I3 01 - Docusnap Recommendations
» []lF 02 - Sample Concepts
T concept - How To - Complete
e IT Concept HowTo
7| 23 Versions
~ (4[5 Backups
7| B 01/04/2020 16:1941
7] E& 01/04/2020 16:17:38
b The first concept

Store Close

IT Concept HowTo | (c) 2021 - All rights reserved Page 41of 54



IT Concept HowTo | Docusnap GmbH @ Docu S na po

6.6. LOAD CONCEPTS

The dialog for importing the desired concept files can be opened using the Load Concepts button in the
Other tab.

After selecting the dcc file, you can import the required concepts and concept templates.

In the Import Mode drop-down box, you can choose whether the concepts should be overwritten if they
already exist. The comparison is carried out via the unique number of the IT concept and not via the name.

Load IT Concepts/Templates 0 X
Company: Docusnap Sports -
Select Data: ChDocusnaph\Sonstiges\IT Concepts.dcc
Import Mode: Owverwrite existing concepts / templates -
Select Concepts/Templates: e [ Concepts
“-[7]F5 EN
e 7 IT Concept HowTo
N /[ Backups
71 B 01.04.2020 16:17:38
- [4] B3 01.04.2020 16:19:41
Load Close
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@ Docusnap

6.7. CLONE CONCEPTS

If a certain concept is selected in the inventory tree, you can select the Clone Concept item in the Concept
tab. This enables the simple cloning of a concept. The concept is duplicated below the selected concept and

the extension — Copy is added.

Docusnap 11

@ Documents Concepts
Discovery
S Templates I'_E"E Store Concepts If% Load Concepts =
L0 ~ fh Docusnap Sports New : = Data Concept
> ¥ IT Documentation
ul . > B Documents ZEdit (O @ - — | Clone Concept
Documentation - E] Concepts
> B2 DE ~ [ IT Concept HowTo | o e
= v EEN ~ [ 1. INTRODUCTION
IT Security » 301 - Docusnap Recommendations (5 1.1. UPLOAD HOWTO AM

> 502 - Sample Concepts
Ql_j » @ IT concept - How To - Complete
License > [E] IT Concept HowTo
Management > [E] The first concept
@ > =g Diagrams
> B Physical Infrastructure
skl > &a Standard Maps
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6.8. ASSIGN CONCEPTS

The Assign button in the Other tab, allows you to mount concepts and directories anywhere in the
inventory tree.

To do this, the desired concept must be selected and the Assign button must be clicked. The node can then
be selected using check boxes.

Assign Concept

Existing Meta Objects

Inventorny -

k

~ Docusnap Sports
~ 1% Infrastructure
~ [ EBd docusnapsports.com

> [ IlEl PROD.DOCUSNAPSPORTS.COM
> [ IlEl SALES.DOCUSNAPSPORTS.COM
> [ 5 Workstations
> [ £ servers
> [T Linux
> [ Mac
> [ L) SNMP Systems
> [1&d Thin Clients
> 1@ HP-UX
> C1EA CIFs

Save Close
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6.9. MIGRATE CONCEPTS

In older Docusnap versions the concepts were stored in a stored path in the file system. If you want to store
these concepts in the database, you must migrate the old concepts. You can also do this using the Other tab
and the Migrate Concept button. For this the path to the old concept files must be specified.
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7. CONCEPT TEMPLATES

The first point of contact with IT concept templates is when you create a new concept:
By default, the following templates are available here

o Recovery Plan

. Emergency Manual

(standard templates are marked orange). In the following screenshot you can also see templates created by
the user (marked green).

In the standard templates, you will find ready-made structures that are intended to give you an idea of what
content should be inserted into these concepts.

Create Conce =
Concept Name: | Language: English -
Template: Template
Empty Document  Docusnap template 1T Concept How To
Template
Recovery Plan Emergency Manua
Cancel
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A template can be created for several reasons:
o Cl template with customized styles, headers, footers, and logos
. Template for a server file so that the documentation of a server always has the same structure.

. A customer-spanning basic documentation that is imported at the customer's site to automatically fill
the customer-specific content (lists, reports, plans, etc.).

o Predefined structures on specific topics

The following elements within the IT concepts are relevant for creating a template:
o Style Sheets

. Table of Contents

. Headers and Footers

. Variables

. specific, dynamic content that can be used across multiple customers

. Placeholders

Style sheets were described in chapter 3. They are used for formatting (font, font size, etc.) and should be
adapted to the desired values at the beginning and saved as a template. You can customize style sheets with
a right click - Change.

Tables of Contents are used for an overview in documents. The individual creation in each concept is
omitted if it is included directly in the template. See chapter 3 for more information.

Headers and Footers - see chapter 3 for more information.

Variables were also described in chapter 3. Variables such as the title, current page number, number of
pages and creation and modification date are helpful when creating a template.

Dynamic content is interesting for system houses that can create basic documentation for customers without
any further intervention by creating a concept. Which contents are offered here and where the restrictions
are, can be found in_chapter 7.2.1.

Placeholders define selected content (reports, plans, prose texts, etc.) within a concept. For example, you
could use a placeholder to define that the installed software of a system is to be included in the server file.
Via the to-do list, you can fill the individual placeholders with content.
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7.1. CREATE TEMPLATES

7.1.1. INSERT PLACEHOLDER

The following contents can be defined as placeholders:

. Report

o File (dynamic)
. Data

. Map

. Diagram

o Text

o Variable

You can create a new placeholder via the Insert - Placeholder tab.
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When creating the placeholder, you must enter information regarding an action text and description. This

information will be available later in the task list.

An object filter is also required. Here you select which object from the data tree you want to store later in

the concept. In the following example it is a list of the inventoried Windows servers.
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All placeholders stored in the concept can then be found within the task list. The task list displays the
If you now select the control, a dialog box opens in which you can

description and action text for a control.

enter the selected content:
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7.1.2. SAVE TEMPLATES

You can save a finished template in the tab General - Save - Save as template. You can then use this
template when creating a new concept.
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7.1.3. CUSTOMIZE / MANAGE TEMPLATES

If you want to adapt an existing template, you can do this in the Concepts — Other - Templates tab.

You will now be listed the templates you have created yourself. Open allows you to open the template,
make adjustments, and overwrite the existing template or save it under a new name.
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7.2. REUSE TEMPLATES

Templates are designed to reduce the amount of work required to create new documents.

Placeholders can be used to define concept contents.

Furthermore, you can already store data from the Docusnap database in the concept - for example, a list of
all inventoried domain controllers:

Name Type Virtualized
DOSPDCO1 DC Yes

DOSPDCO2 DC Yes

This content can now be updated to your Docusnap environment. Right-click on the table above and select
Update. The table will now show your inventoried domain controllers, if you look at this concept HowTo in
Docusnap.

This way the concepts and templates are reusable - also in other Docusnap environments.
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7.2.1. REUSABILITY RESTRICTIONS

Chapter 6 describes how to save and load concepts and concept templates. If you load the concepts into
another Docusnap environment, you can automatically adopt some of the content, as discussed earlier.
However, this transfer of data has restrictions.

The contents of a concept can only be transferred up to a certain level of detail. Overview lists, such as
inventoried servers, workstations, Linux and other systems, can be used very well. ADS users and group

overviews as well.

However, if a specific object is stored - e.g. the name of a system, an ADS group or the group memberships
of groups - no assignment can take place here.

Content that cannot be assigned is displayed with an error message and an entry in the error list:
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